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Muutama sana tasta materiaaleista

« Tama materiaalipaketti noudattaa Innokas- « Kokeile rohkeasti ohjelman toimintoja!
hankkeen Robotit valtaavat fysiikan Klikkaamalla laitteita ei pysty rikkomaan!

luokan -tyopajoissa tehtyja harjoituksia. . Lahestymlstapaa ja tehtavanannon

« Tybpajan ja taman materiaalipaketin on avoimuutta voi varioida oppilasryhman
tarkoitus helpottaa datalogging-ohjelmiston taitotason tai oppimistavoitteen mukaan.
kayttdonottoa ja esitella tapoja, joilla Lego- Materiaalista 10ytyy tahan vinkkeja.

robotiikkaa voidaan hyddyntaa ylakoulun
fysiikan ja vahan matematiikankin
oppitunneilla.

« Taman materiaalipaketin lisaksi kannattaa
tutustua myos Lego Mindstorms Educations
EV3-ohjelmiston Quick Start ja Robot

» Materiaalipaketti etenee harjoituksesta 1 Educator-osioista I6ytyviin video-ohjeisiin
harjoitukseen 2 jne.... Harjoitusten sisalla seka innokas.fi sivustolta [oytyviin Erkki
tybvaiheet on usein numeroitu. Hautalan, Juha Kokkosen, Lauri Parkkosen ja
Numeroinnilla on tarkoitus helpottaa Pekka Piholan tekemiin EV3-ohjelmointia
toimintajarjestyksen omaksumista. koskeviin ohjeisiin.

Harjoitusten lomasta loytyy oranssilla
ylaotsikolla merkittyja kertaustehtavia, joissa
juuri opittua taitoa testataan esimerkiksi eri
anturilla (sensorilla) ja samalla opitaan lisaa.
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Mita tulee tietda/osata ennen datalogging -mittausten aloittamista?

EV3 -KESKUSYKSIKKO

Ohjelman lataus —
usb —kaapelilla PC:Ita

Sensoriportit 1-4

Kaynnistettava
ohjelma

Ohjelman lopetus
Keskusyksikon sammutus

Moottoriportit

Keskusyksikon kdynnistys
Ohjelman kaynnistys

9.10.2016
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Valintapainikkeita




Ohjelmointindkyma 1/2

G Ohjelman teko aloitetaan
raahaamalla kuvake tahan

e Toiminnot "klikkaa vihreda palkkia
hiiren vasemmalla painikkeella

e Ohjelmavuon ohjaus

Q Anturit

Q Dataoperaatiot
Q Edistyneet ohjelmapalat

0 Omat ohjelmapalat

IWW' 9.10.2016
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File Edit Tools Help

200000

SERTERHE
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Ohjelmointindkyma 2/2

e Liiku Yksi moottori keskikoko/iso

Q Liiku Kaksi moottoria yhdessa/
erikseen

@ Valo @
@ valo

@ Tahan voit lisata ohjeita teksting,
kuvana, videona ...

e e 1 1 ]

ARt e |

yE]

1
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Mita Lego-roboteilla voi tehda ylakoulun fysiikan oppitunneilla?

* Yksinkertaisimmillaan legorobottia voi
kayttaa fysiikan liikkemittauksissa
liikkuvana objektina, jonka liiketta
voidaan tutkia perinteisesti Kannykan
kellon ja mitta-asteikon avulla.

» Robotin hyvana puolena on sen tehon
saadeltavyys, jolloin lilkkemittaus voidaan
toistaa samalla objektilla eri tehoilla.

Kuvassa Vanttilan koulun oppilaita mittaamassa
robotin liiketta.
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Ensimmaiseen liikkemittaukseen tarvittava ohjelma:

Avaa Lego Mindstorms EV3 -
ohjelma-> File > New Project
- Programming - Open

9.10.2016

@ LEGO MINDSTORMS Education eacher Editic

File Edit Tools Help

Lol Project X B3

Z” 3 program X |[+]

'j

1. Valitse vihrea
Toiminnot-palkki

2. Raahaa Move
steering- kuvake
Aloitus- kohtaan
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Valitaan mittauksessa kaytettava mittausaika ja teho:

Ohjelma kaynnistetaan robotin ohjelma-tiedostoista

File Edit Tools Help

Moottorit pyorivat E sekunnin|ajan|70 % | teholla.

Robottia liikutellaan
moottoreilla B ja C

Ladataan ohjelma
robottiin
(Download)

- ) N N

SRTTHHD
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Kahden eri tehoilla suoritetun mittauksen
mittaustulokset voidaan taulukoida ja niista voidaan
piirtaa kuvaajat esim. Excel- ohjelmistolla. Mikali
mittaustuloksiin sovitetaan suora, paastaan
ihmettelemaan suoran kulmakertoimen merkitysta
robotin liikkkeen kannalta. Mikali kulmakertoimen
kasitetta ei ole kaytettavissa, voidaan puhua suoran
jyrkkyydesta. Oppilas yleensa oivaltaa, etta tassa
mittauksessa suoran kulmakerroin kuvaa liikkeen
nopeutta ja pystyy paattelemaan mittauksessa

kaytetyn nopeuden yksikon.

0 0
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2,9
4,0

4,9
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1,2
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0,5

y = 0,4073x

y = 0,1815x

Kuvaajat esim. Excel, Nspire
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MITA MUUTA LEGO-ROBOTEILLA VOI TEHDA FYSIIKAN JA MATEMATIIKAN OPPITUNNEILLA?

Ohjeistusta datalogging- « Avaa Lego Mindstorms Education EV3 ohjelma
mittauksiin l0ydat

videoina seuraavasti: I Val!tse Robot Edu.cator
« - Valitse Data Logging
e = Tutustu seuraaviin toimintoihin:

Live Data Remote Data

Oscilloscope Logging Logging

Autonomous Graph
Data Logging Programming

 Tutustutaan nyt ndihin toimintoihin yldkoulun fysiikan
liikemittausten yhteydessa.

!WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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EV3- robotin valmistelu liikemittauksiin:

Kiinnita ultradaanipaikka-anturi porttiin
1,2,3tai 4

G Ultradanipaikka-anturi

G Kiinni portissa 4

e Kaapeli tietokoneelle

Yhdista robotti tietokoneen usb-porttiin ja
kaynnista robotti.

IWW' 9.10.2016
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Tehdaan aluksi mittaus, jossa robotti toimii tietokoneeseen liitettyna paikallaan olevana
mittalaitteena (live datalogging).

Live datalogging ultraaanipaikka-
anturilla

Harjoituksessa mitataan
ultradanipaikka-anturilla etaisyytta
liikkuvaan kohteeseen ja piirretaan
liikkeen (aika,paikka) -kuvaajaa
samanaikaisesti. Harjoituksen
tavoitteena on tutustua (aika,paikka)-
kuvaajan muotoon ja oppia
tulkitsemaan liikkeen (aika, paikka)-
kuvaajaa.

!WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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Mittauksen suoritus:

Avaa Lego Mindstorms EV3 -ohjelma New Project |2 Experiment

o X
File Edit_Tooks _Help I D
o] '+ EiLabVIEW
Program
5\ \
|
Experiment
Create a new data logging experiment]
QOpen
"m"'r Open Recent

'WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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Tee nyt seuraavat valinnat:

£=]

File Edit Tools Help
oM Project* X B3

7] ® Expermentx | S @lals)| @

[em]
255

1. Valitse mittauksen kesto

2. Valitse naytteenottotaajuus

3. Valitse ultraaanipaikka-
anturi...

4. Voit mitata etaisyytta
..ja portti 1,2,3 tai 4, johon kohteeseen senttimetreing
se on kiinnitetty tai tuumina

[Seconds w |

Int Units Setup | -m__

=
@ DUI’atIOrI
10 Secunds v

Rate
|E| | 10 ][SamplesperSecond
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£=]

File Edit Tools Help
LM Project* X @i lcuw iy +

of B o 2=

1. Poista tarvittaessa ylimaaraiset 2. Poista oskilloskooppimoodi
anturit painamalla X, jotta jaljelle jaa kaytosta
vain ultradanipaikka-anturin kuvaaja

3. Mittaus kaynnistyy tasta
(download and run)

| Experiment Units Setup Sensor Setup
Duration: I_. | | Ultrasonic Sensor v | | Distance Centimetres
(10|
[ v]
Rate:
| 10 | Samples per Second

g Connection Type: USB

’WM! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 15



Liikuttele sopivan suurta estetta esim. oppikirjaa ultradaanipaikka-anturin edessa ja piirra jokin
kuvaaja.

£

File Edit Tools Help

[

x

+ E LabVIEW

@ QoL 2=m) | 51q)

Voit poistaa kuvaajan

Skaalaa mittauksen jalkeen paikka- tasta

akseli sopivaksi syottamalla kenttaan
sopiva maksimietaisyys

Voit kdynnistaa uuden
mittauksen tasta

Firmware: V1.01H

- |:10 | |[ v |

Rate:
=] | N || Samples per Second v

g Connection Type: USE

Sensor Setup @“E\,'g
@ Duration: | . | Ultrasonic Sensor Distance Centimetres v @ |
>

9.10.2016 EV3 - Datalogging / © 2016 Innokas 16



Piirra estetta (esim. kirjaa) liikuttelemalla seuraavat kuvaajat. Tavoitteena on tutustua
liikkeen (aika, paikka) -kuvaajaan.

'WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 17



Kertaus 1: Live datalogging LAMPOTILA-ANTURILLA

Toista Harjoitus 1, mutta
kayta anturina lampotila-
anturia, jonka kiinnitat
esim. porttiin 3

Kokeile lampdtila-anturin
toimintaa:

(WW, 9.10.2016

. Mittaa lampoétilaa esim. 10 sekunnin ajan
. Tutki, saatko nakyviin haihtumisessa tapahtuvan

lampotilan muutoksen (vesi /etanoli/asetoni).

. Tutki kuuman veden jaahtymista vaaleassa ja

mustassa astiassa (voit kayttaa samanaikaisesti kahta
lampotila-anturia eri porteissa)

. Tutki, saatko nakyviin lampiman veden

sekoittamisessa tapahtuvan lampdtilan muutoksen.

EV3 - Datalogging / © 2016 Innokas 18



Harjoitus 2: Remote datalogging ultradanipaikka-anturilla

Toistetaan Harjoituksen 1 liikemittaus mutta irrotetaan nyt robotti tietokoneesta mittauksen ajaksi.
Robotti toimii siis paikallaan oleva mittalaitteena, joka ei ole mittauksen aikana kiinni tietokoneessa
(Remote Data Logging).

to)
File
& 'roject* Project2* x &3

o |[l% Experiment X |[+] @“@@[§|El|m] [‘)|(’] @] [:l:]

X

Edit Tools Help

3.Etsi ohjelma robotin
tiedostoista (talla nimelld) ja

2. Aja ohjelma robottiin paina kdynnistysta. Liikuttele
tasta (download) ja irrota kirjaa robotin edessa. Robotissa
robotti tietokoneesta. vilkkuu vihrea valo mittauksen
ajan. Kun mittaus on tehty,
kiinnita robotti tietokoneeseen.

1. Tee samat
asetukset kuin
harjoituksessa 1

=]

1] 1 2 3 4 5 3 7 8 9 i
{} | Experiment Units Setup Sensor Setup E@“EVB ] .__..:
2 DLiroatior;:emnd \_. | | Ultrasonic Sensor v | | Distance Centimetres v | [z] | d m Firmware: V1.01H | B |
(10 | sesonds v] =
2l | cate: | | [ X} | =:] Connection Type: Us8 LPJ
ER| || 10 |[Samples per Second v [ | B
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&
File Edit Tocls Hels
# LabVIEW

0 Q) (2 Em) Q] A

o || & Experiment X |[+]
2. Loydat suoritetun 1. Tuo mittaustulos
mittauksen talla nimella. ohjelmaan tasta E—

Klikkaa kansio auki. (upload)

Data Log File Manager 3. Klikkaa tiedostoa
saadaksesi kuvaajan
hakyviin.

24/02/2016 21:42:46 N

February 24, 2016 21:42:46

Delete All

1

SooanE 4. Saat mittaustuloksen siirtymaén G EE

istance Centimetres m Firmware: V1.01H
3

Duration: tietokoneelle tasta (import)
10 Second
l: g Connection Type: USB

Rate:
| 10 ][Samples per Second v | .

’WM! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 20



Tutkitaan valaistusvoimakkuuden Tutki, miten mittaustulokseen vaikuttavat

muutosta valonlahteen etaantyessa valinnat reflected light intensity/ambient
paikallaan olevasta robotista, joka ei ole light intensity

mittauksen aikana kiinni tietokoneessa. Kokeile Vari L

Voit kayttaa valonlahteena esim. Okeile varisensorin toimintaa

kannykan taskulamppusovellusta.

Kiinnita valaistusvoimakkuusanturi esim.
porttiin 1 ja laadi datalogging ohjelma
valaistusvoimakkuusanturille.

Kokeile Remote Dataloggin toimintoa:

Aja ohjelma keskusyksikkoon -->
(download) ja irrota datakaapeli
tietokoneesta, suorita mittaus ja siirra
data tietokoneelle <-- (upload).

[WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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Harjoitus 3

S|
File Edit Tools Help

Seuraavan harjoituksen
tavoitteena on yhdistaa

. T . Laaditaan ohjelma, jonka avulla robotti
ohjelmomtl Ja datalogglng etaantyy tasaisella nopeudella

(Autonomous Data esteestd (esim. seina) ja samalla mittaa
Logging) sek3 luoda uI‘F.r.aééni'pailfkfa‘-apturilla .
Ai . liikk etdisyytta seindsta. Ajetaan ohjelma
poNnjaa tasa_lsen IIKKEEN robottiin ja suoritetaan mittaus.
matemaattiselle Mittauksen jilkeen kytketdan robotti
mallintamiselle tietokoneeseen ja piirretaan
’ datalogging-ohjelmistolla (aika, paikka)-
kuvaaja robotin liikkeesta.
@ Open Project

Tata kuvaajaa kaytetaan myads
harjoituksessa 4 tasaisen liikkeen
kuvaajan matemaattisessa
mallintamisessa.

Robo( Educator

Open Recent

!WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 22



Ohjelmointi

Avaa Lego Mindstorms Education EV3 -ohjelma

New Project/-> Program

(]

File Edit _Tools Hell | |
=] B Lal VIEW

5\ \

|

Program Program
Create a new program.
/2
Cpen
Experiment
o ‘

'WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas



Laaditaan aluksi mittausohjelma

Project X

o || 32 Program X |[+]

1. Ohjelma alkaa
tasta

3. Valitse Data
Logging -kuvake
4. Raahaa hiirella
Data Logging -kuvake
ohjelman alkuun
-J- ;

9.10.2016 EV3 - Datalogging / © 2016 Innokas 24
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Tehdaan tarvittavat valinnat ultradanipaikka-anturilla suoritettavaa mittausta varten.

=]

File Edit Tocls Help
Eo M Project* x B8

+ || 3 Program X |[+] x B

1. Anna mittausohjelmalle nimi

2. Maarita portti, johon ultraaanipaikka-
anturi on Kiinnitetty

_— 3. Valitse ultraaanipaikka-
Gyro S¢ isor anturi...

... ja mittaus senttimetreina

4. Valitse
mittaustapa

) DV Advanced 3

nergy Meter

NXT Sound Sensor IS Eistance Inches

‘ M e Presence

| -y

STEZTRDTED

NYE|D

’WM! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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Laaditaan nyt ohjelma, jolla saadaan robotti liikkumaan mittauksen aikana (= robotti etdantyy
seinasta vakionopeudella).

S

File Edit Tecls Help

oM Project* x B8

« || 3 Program X |[+]

1. Valitse vihrea
Action-palkki

3. Raahaa hiirella
Move Steering - 2. Valitse Move

kuvake ohjelman Steering -kuvake
jatkoksi

’WM! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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S

File Edit Tools Help

4. Valitse teho ( Power).
Negatiivisella teholla saat
robotin liikkumaan taaksepain.

5. Valitse
i} on mittausaika

(@ on orsecones

4er) On for Degrees

6. Tama kuvake lopettaa
Datalogging -mittauksen.

@ On for Rotations

Kuvake l6ytyy sinisen
Advanced -palkin takaa.

’WM! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 27



Mittauksen suorittaminen

1.

Kytke robotti tietokoneeseen ja aja ohjelma robottiin (download).
Irrota robotti tietokoneesta ja aseta robotti noin 10 senttimetrin paahan esteesta.

Etsi ohjelma robotin tiedostoista (Project ->Program) ja kaynnista ohjelma (vihrea
valo vilkkuu mittauksen ajan).

Voit tehda useita mittauksia ja valita sitten tulostenkasittelyvaiheessa parhaiten
onnistuneen mittauksen.

Piirra mittauksen jalkeen (aika, paikka)-kuvaaja Datalogging -ohjelmistolla tuomalla
mittausdata tietokoneelle Upload -toiminnon avulla (seuraava dia)

!WM! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 28



1. Saat lisattya askeiseen ohjelmaan tulosten kasittelya varten
sivun vaIitsemaIIaIFiIe > Add Experiment Itai painikkeen

LN Project® X B

# [ @ program | & Experment x| +) |« | O 25 | @ bl¢) | QRly)| M

255 ]

2. Tuo mittaustulos
] Compur il B tietokoneelle (Upload)

|Name Size Date

[ BrkProg_SAVE A
P~ Project
[ likemittaus.rdf 308 B
[ liikemittaus_1.rdf

[} MyData_1.rdf

8o
Ddikte All April 05, 2006 19:00:25

[ Seconds

3. Valitse hiiren avulla
paras mittaus ja lataa : Erem— :
se tietokoneelle (Import) Z

Samples per Second v | E|

enmann) (5]

Sensor Setup

'WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas 29



Todetaan robotin liikkeen olleen tasaista. Kuvaajan analysointia jatketaan harjoituksessa 4.

=

File Edit Tools Help

b4

| 10 |[Seconds ¥ |

Rate:

LK

o
= T L L] T L ) L}
0 1 2 4 3 6 7 8 10
[ Seconds v |
Experiment Units Setup Sensor Setup
EV3 [(TITIIT1]
g | Duration: » | [Uttrasonic Sensor v | | Distance Centimetres v)(av](mv](x]]| | Firmware: V1.01H
| >

Y a Connection Type: UsE

E | 10 || Samples per Second

¥

|

| (8]

DOy

9.10.2016
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Tutkitaan valaistusvoimakkuuden
muutosta robotin etaantyessa tasaisella
nopeudella paikallaan olevasta
valonlahteesta. Robotti ei ole mittauksen
aikana kiinni tietokoneessa. Voit kayttaa
valonlahteena esim. kannykan
taskulamppusovellusta.

Kiinnita valaistusvoimakkuusanturi
robottiin ja laadi mittaukseen soveltuva
mittausohjelma.

Aja ohjelma keskusyksikkoon 2>
(download) ja irrota datakaapeli

tietokoneesta, suorita mittaus ja siirra

data tietokoneelle & (upload).

(WW’ 9.10.2016

EV3 - Datalogging / © 2016 Innokas

Tutki, miten mittaustulokseen vaikuttavat
valinnat reflected light intensity/ambient
light intensity

Kokeile varisensorin toimintaa

31



Harjoitus 4

Tutustutaan seuraavaksi kuvaajan analysointity6kaluun. Harjoituksen tavoitteena on sovittaa
mittaustuloksiin sopiva kayra ja maarittaa tuon kdyran yhtald. Tasaisen liikkeen tapauksessa kuvaaja
on suora.

@ x
File Edit Tools Help
Eo M Project* X JEE B CabVIEW

7“ 2 Program X H & Experiment X ]IEI E :J i ;j

2Ee @l O |

4B point Analysis

[cm]|

53 Eetﬁun Analysis Section Analysis

o

X-Axis Position Start: 0.68  End: 3.40

Mame Min Max Mean |Median | Std Deviation | Integral | Curve Fit |
[l Ultrasonic_p4 01 | 22.80 | 58.80 | 41.28 | 41.10 10.82 99.11 | [None v |

1. Valitse Analysis- tyokalu...

.. ja sieltd Section Analysis

2. Valitse hiiren avulla alue,

/ jota haluat tarkastella

o -
0 7 4 5 & 7 8 ] 10
[Seconds v |
¢ |Experiment UnitsSetup  [Sensorsetwr _________________________________ |l®[es [0 1111
& |DL.irOatilTr'n o | | | Uttrasonic Sensor v | | Distance Centimetres 2} (M| (x| 1 | Firmware: v1.01H B
Seconds v —
=l - | | [ n/ ] | = Connaction Tuna: 1158 L& o
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Sovitetaan nyt valitun alueen mittaustuloksiin suora:

£=]

File Edit Tools Help
Project* X g

7” 3 Program X " # Experiment X ]El

[.cm

255 ] Section Analysis
K-Axis Position Start: 0.68  End: 3.40

1 [ Name Min |Max |Mean |Median i urve Fi
. n - oy
100 o

| Valitse Curve Fit...

..ja Linear
8 9 10
[Seconds v |
Sensor Setup E@ ‘ [E\l’3 ] EV3

Duration: | . | | Ultrasonic Sensor ¥ | | Distance Centimetres m Firmware: V1.01H
| 10 | Seconds w | 4 SW1. B
Rate: | | [ v) =:| Connaction Type: USB |£|

] NE]

| 10 ][Samplesper&iecond v |

'W/{“M! 9.10.2016 EV3 - Datalogging / © 2016 Innokas



Harjoitus 5

Harjoituksen tavoitteena on vahvistaa kuvaajan tulkintaa ja sen
matemaattisen mallintamisen kasitteiden (suoran kulmakerroin

Askeista liikettd mallinsi suora, jonka

yhtald oli ja vakiotermi) ymmartamista liikkeen tarkastelun yhteydessa.
= 15,00 x + 9,79 (K&yt4 itse piirtamasi s e N hn y -
Syuoran yh,):(émé) (fayta itse piirtamas Tata harjoitusta voi hyodyntaa myos matematiikassa funktioiden

kasittelyn yhteydessa.

Piirra legorobotin liikkeen avulla suora,
jonka yhtaldé on

« y=1500x + 30

« y=-1500x + 30

« y= 30,00x+9,79

@ x
. . . File Edit Tools Help
Mieti ensin, missa kohdissa joudut ° o + B LabVEW
ohjelmoimaan robotin uudelleen. /|| programx | & Experment x |+ B 00E 2Em 0
fem|

[Eection Anayss

X-Axis Position Start: 0.88  End: 3.40

‘Name Min Max Mean | Median | Std Deviation | Integral | Curve Fit ‘
o ] |Linear v ‘

|

-9 F
=
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Harjoitus 6

Voit my6s muuttaa harjoituksen lahestymistapaa ja pyytaa
oppilasta tulkitsemaan ohjelmakoodista, miten robotti tulee

Laadi robotille ohjelma, jonka avulla o . . . s as .
voit piirtia mieleisesi likkeen kuvaajan. liikkumaan. O.ppllasta voi myos pyytaa hahmf)tt?leﬁ\aan kuyaajan
Esimerkkiohjelma alla: muodon pelkan kuvakekoodin perusteella. Taman jalkeen tilanne

voidaan realisoida robotin avulla.

@ 5o .aa@lﬂgﬁ"}”aa@f@@"'aa@lﬁ?@"ﬂai O @
W{ml (O feteiad | @ Feieetaivd [ @ fedeeiai [ @)

!WW! 9.10.2016 EV3 - Datalogging / © 2016 Innokas
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Harjoitus 7

Alla harjoituksen 6 ohjelmalla tuotettu
liikekuvaaja. Voit myds aloittaa tasta
kuvaajasta ja pyytaa oppilasta
kuvailemaan, miten robotti on
liikkunut. Ohjelmointia painotettaessa
voidaan oppilasta taman jalkeen pyytaa
laatimaan ohjelma, jonka avulla robotti
liikkuu kuvaajan mukaisesti. Ohjelmaa
voidaan liittda myds ultradanipaikka-
anturin mittausohjelma (harjoitus 3),
jolloin voidaan piirtaa kuvaaja.

IWW' 9.10.2016

e

File Edit Tools Help

Eo M Project* x |BS

[ #][ @ Programx || & Experment x |+

x

{8 LabVIEW

(@) | | QT (2 [Em) )

| cm |

zss

-,

T
8 10

[Seconds v |

Experiment Units Setup

Sensor Setup

Duration:

| 10 |[Seconds ¥ |

Rate:

|10 || Samples per Second

v

| @ | [ Uitrasonic sensor v | | Distance Centimetres

\ [ v]

(DOl
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Harjoitus 8

Voit piirtaa harjoituksen 7 mukaista ohjelmointitehtavaa varten kuvaajan myds ilman ohjelmointia
Prediction-tyokalulla avulla

(]

File Edit Tools Help

| 3 Programx || % Experment x |+ z'p \'fzg’irsﬁ::?gsl’;e’ryékalu

[cm|

255 ]
2. Robottiin on liitetty
3. Tee ennuste kynan avulla ultradanipaikka-anturi porttiin
5 vapaalla kadella
—
!" Prediction Name: | P_Ultrasonic_02 | J
/
/" Sensor: | Ultrasonic:DistanceCentimetres:4 v |
!
/ : 0 |#| prediction Type:
100 - / 4, Vall'l'se kyna...
_,"f [m) @ Pencil I
ym————-
/ .ja sulje D Linear v
/ valintaruutu (OK) - .
!
!
’.f [ Ok HI Cancel ]
1o

0 1 2 3 4 5 6 7
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Harjoitus 9

Ennusteen tekemisessa voidaan hyddyntaa myos kayran yhtaloa. Kokeile tata toimintoa.

Ol Project* X B

?” 2 Program X ” & Experiment X |I£l

o -
=

0 1 2 3 4 5
_4

]

|.cm]
255 ] -
P
-
s
200 P
e
-~
P
Prediction Name: | P_Ultrasonic_02 |
Sensor: | Ultrasonic:DistanceCentimetres:4 v | 1 KOkeile +ata
Prediction Type: toimintoa.
100 e
S
S o
,F T
O] | Linear v |
y= [30 | %+|-100 |
Do P [ Apply H Ok H Cancel ]
S -
~ -
~_ -
S e e e e e AL B S e e e e e | f T
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UUTTA EV3 - sukupolven roboteissa

UUTTA EV3 - sukupolven roboteissa
aiemman sukupolven NXT-robotteihin
verrattuna on mahdollisuus KUVAAJAN
AVULLA OHJELMOINTIIN (Graph
Programming) Tama on mukava lisa
tyoskentelyyn ohjelmoinnin opetusta
painotettaessa. Tyotapa tuo myos rutiinia
liikkeen kuvaajan tulkintaan.
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Harjoitus 10

Ohjelmoi Graph Programming avulla robotti liikkumaan alla olevan kuvaajan mukaisesti.

=] x

File Edit Tools Help

Lol Project* x B3

# | 3 Program X | % Experiment x |+ E] X @?I@ =] e ||l Céj
[deg)| ([deg)| [em)
180 [ 180 7 |0 : *
1 1. d—== A\ A\ /N L
] 1=
] 1 / e ./ N\
2 s s s C 10
[Seconds v |

— = MEE |uEEEE|
f >Q| @ l & L m Firmware: V1.01H @
\_I[&J—:T.; =:| Connection Type: Usg |Z| @
| 525 < 5o

Robotti Idhestyy estettd, kunnes 20 cm:n etdisyydella alkaa peruuttaa ja 40 cm:n etdisyydella
aloittaa uuden ldhestymisen.
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Ohjelmointi kuvaajan avulla: | I

.
Avaa Lego Mindstorsm EV3 - P oroject” x ,,
ohjelmisto - File > New

Experiment - Open

1. Valitse Graph 2. Maarita kaytossa 3. Saat kayttoosi
Programming oleva anturi kolme ohjelmointi-

aluetta.

Z“ # Experiment X “El

Star Zone, ...

Retangle Zone...

..ja Circle Zone

EE—— |
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1. Valitse

alueet (v)

S

File Edit

Tools Help
oM Project* X B3

Z" # Experiment X IIEI

@) | ) L3

-
‘ leo

| 40.00 ||
= Ee—
2. Aseta sopivat etaisyysrajat alueiden valille
muuttamalla ruutuun haluamasi luku . Tassa
harjoituksessa liiketila muuttuu 20 cm ja 40
cm etaisyydella esteesta.
| 20.00 ||
Te—

3. Aseta sopiva maksimietaisyys muuttamalla

10

ruutuun haluamasi luku
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Alueen 1 ohjelmointi (Star Zone): 60 ja 40 senttimetrin valisella alueella robotin tulee Idhestya seinda

File Edit Tools

Help

L0l alueohjelmointi.ev3 * X JBE

|| & Experiment x |[+

B CabVIEW

] x MMIEE]

B 5e] | QT4

deg

150 ]

[@ea)

150 ]

cm ||

1. Valitse alue ja avaa
ohjelmointiruutu hiirella
klikkaamalla

2. Ohjelmoi robotti
likkumaan eteenpain
(Move Steering)

1
10

(Seconds v |

Chromium E
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Alueen 2 (Retangle Zone) ohjelmointi: 40 ja 20 senttimetrin valisella etaisyydella robotti jatkaa
toisella alueella maariteltya liiketilaa eli uutta komentoa ei tarvita.

File Edit Tools Help

to M alueohjelmointi.ev3 * x B3

o || % Experiment X |[+

[deg|| |[deg]| |[cm]

1s0 | |50 | o *
at

| 40.00 ||

| 20.00 ||

3

10

[ Seconds v |

Slafalal

[@“Eva

[T T —

m Firmware: V1.01H
>
g Connection Type: USE
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Alueen 3 (Circle Zone) ohjelmointi : ohjelmoi robotti peruuttamaan eli etaantymaan seinasta alle 20
senttimetrin etaisyydella

File Edit Teols Help

oM alueohjelmointi.ev3 * x B8

o || % Experiment X |[+]

[deg|| |[deg]| ([em]

120 | |tz0 ] .
o

| 40.00 ||

| 20.00 ||

' @lq

10

| Seconds v |

__

ﬁ' i ﬁ [CEE
D@ - 99 @ L Firmware: V1.01H
] - l‘ [—| — S— l‘ =:| Connection Type: Usg
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1. Kun ohjelma on valmis, lataa se
robottiin (Download)

2. Aseta robotti hieman yli 40
senttimetrin etaisyydelle seinasta ja
kaynnista ohjelma.

3. Mittauksen jalkeen tuo mittaustulos
tietokoneelle (Import)
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Valitse onnistunut mittaustulos (harjoitus 3) ja lataa se koneelle (Import)

=]

File Edit Toels Help
Project* X &g

2

X

| x[E 2 Em | (&)

[deg| [deg)| |lcm]

150 | [ts0 | e : -

100 100 :

_
] 40.00
o op—2m0] | Computer ) ) BN )
|-
\ Name Size Date /
b by - [ liikemittaus_1.rdf| 308 B -
i [ liikemittaus_2.rdf| 8798
] [ liilkemittaus_3.rdf| 873 B
i J [} MyData.rdf 889 B
[ 20.00 |
1 e O _ [} MyData_1.rdf 890 B 7
E 1/® [} MyData_2.rdf 890 B
100 | 100 \/\/\/\/
o [ Project2 v
[ Import ] [ Deleta Delete All S DB LTLE LIREReT
1 . . .

— (Seconds v]
B EV3
® = [EEE |-

f
| Firmware: V1.01H
| Pl ! © 40 B
\ '—";__';0 g Connection Type: USE [ ®
L] [ °i =
| )] 2]
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Kertaus 4: Kuvaajan avulla ohjelmointi

Ovivahti

Ohjelmoi kuvaajan avulla robottisi
mittaamaan ultradanipaikka-anturilla
etdisyytta ovelle (esim 30cm). Kun henkild
astuu ovesta sisaan, robotti tervehtii
hanta aanitiedostolla.
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Doorway Greeter

Your robot measures the distance across
a doorway. When a person walks through,
the Ultrasonic Sensor measures a lower
distance, and the robot plays the
“Morning” sound file.
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